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[bookmark: _Toc536271576][bookmark: _Toc536271853][bookmark: _Toc536271871][bookmark: _Toc3538726][bookmark: _Toc4763076]Ćwiczenie 11 – Modelowanie przepływu w mieszalnikach o prostych kształtach
[bookmark: _Toc536271577][bookmark: _Toc536271854][bookmark: _Toc536271872]Tworzenie bryły płynu na podstawie geometrii ciała stałego w programie Ansys SpaceClaim. Generowanie automatycznej siatki numerycznej. Symulacja przepływu w mieszalniku z mieszadłem Rushtona w Ansys CFX. Opracowanie wyników w Ansys CFD Post.
[bookmark: _Toc3538727][bookmark: _Toc4763077]Opis problemu
[image: ]n = 60 obr/min

[bookmark: _Ref1222726]Rys. 1. Warunki brzegowe dla przepływu wymiennik płaszczowo-rurowy

Na Rys. 1 przedstawiono uproszczony mieszalnik wyposażony w wirnik Rushtona. W zbiorniku znajduje się powietrze, a wirnik obraca się ze stałą prędkością obrotową 60 obr/min. Głównym zadaniem jest zamodelowanie ruchu obrotowego wirnika i sprawdzenie jaki ma on wpływ na pole przepływu w zbiorniku. 

[bookmark: _Toc3538728][bookmark: _Toc4763078]Cele ćwiczenia
· Tworzenie geometrii płynu w module Ansys SpaceClaim za pomocą narzędzia Enclosure
· Generowanie automatycznej siatki numerycznej 
· Wykonanie symulacji numerycznej przepływu w mieszalniku za pomocą modelu Frozen Rotor przy wykorzystaniu Ansys CFX
· Wykonanie dodatkowych obliczeń dla modelu turbulencji SST i porównanie wyników za pomocą Ansys CFD Post
[bookmark: _Toc3538729][bookmark: _Toc4763079]Instruktaż wykonania ćwiczenia
1. [bookmark: _Toc3538730][bookmark: _Toc4763080]Włączanie Ansys Workbench
· Włącz Ansys Workbench przez Menu Start > Wszystkie programy > ANSYS 19.2 > Workbench 19.2
[image: ]
2. [bookmark: _Toc3538731][bookmark: _Toc4763081]Zapisywanie projektu
Dobrą praktyką jest, aby zapisywać każdy projekt w oddzielnym katalogu. Dodatkowo zaleca się nie używania w nazwach katalogów i plików polskich znaków, spacji i znaków specjalnych (np. @#$%^& itp.).
· Utwórz katalog o nazwie Cw11
· W Workbench zapisz nowy projekt o nazwie Cw11RushtonImpeller w katalogu Cw11 za pomocą File > Save as
[image: ]
3. [bookmark: _Toc4763082][bookmark: _Toc3538733]Tworzenie geometrii płynu 
SpaceClaim jest to narzędzie do generowania geometrii. W tym ćwiczeniu zostanie narysowana bryła płynu w zbiorniku na podstawie geometrii mieszadła Rushtona. W tym celu zostanie wykorzystane narzędzie Enclosure.
· W oknie po lewej stronie w panelu Component Systems kliknij lewym przyciskiem myszy (LPM) na Mesh i przeciągnij do panelu Project Schematic po prawej stronie
[image: ]
· Klikając prawym przyciskiem myszy na Geometry wybierz Import Geometry a następnie Browse
[image: ]
· Wybierz plik RushtonImpeller.stp który został dołączony do plików potrzebnych do wykonania tego ćwiczenia. Pamiętaj, aby jako rodzaj pliku wybrać typ STEP lub All Geometry Files
 [image: ]
4. [bookmark: _Toc4763083]Tworzenie geometrii płynu na podstawie brył typu solid
SpaceClaim jest to narzędzie do generowania geometrii. W tym ćwiczeniu zapoznasz się z dalszymi możliwościami edycji geometrii w SpaceClaim.
· Aby otworzyć SpaceClaim kliknij dwukrotnie LPM na komórkę Geometry
[image: ]
· Na ekranie pojawi się interfejs graficzny programu SpaceClaim z widoczną geometrią. 
[image: ]
· W celu obrotu modelu naciśnij środkowy przycisk myszy (SPM) i porusz myszą
· W celu przesunięcia modelu wciśnij SPM a następnie klawisz Ctrl i przesuń mysz
· W celu przybliżenia lub oddalenia widoku naciśnij SPM a następnie klawisz Shift i przesuń mysz. Ten sam efekt można uzyskać za pomocą obracania SPM
· Dodatkowo kontrolki ruchu znajdują się w zakładce Design 
[image: ]
· W zakładce Prepare wybierz ikonę Enclosure i lewym przyciskiem myszy (LPM) wybierz bryłę
[image: ]
· Po lewej stronie ekranu w polu Options – Enclosure > Create Options > Enclosure type wybierz Cylinder, a następnie wybierz ikonę pozycjonowania [image: ]i LPM wybierz oś Z
[image: ]Wskaż oś Z

· Dla wymiaru poziomego wpisz wartości 12 mm. W celu przejścia do drugiego wymiaru naciśnij klawisz Tab i wpisz 15 mm. Wynik zatwierdź klawiszem Enter
[image: ]
· Wyjdź z polecenia za pomocą klawisza Esc
· Wyśrodkuj widok wybierając klawisz H lub ikonę Home w zakładce Design
[image: ]
· Rozwiń pozycję Enclosure, która powstała w drzewie systemowym
[image: ]
· Prawym przyciskiem myszy (PPM) kliknij nazwę Enclosure przy zielonym prostopadłościanie, a następnie Move to New Component
[image: ]
· Wybierz polecenie Enclosure i 1) LPM wybierz nowo utworzony komponent, 2) odznacz opcję Symmetric dimensions, 3) zastosuj wymiary jak na rysunku
[image: ]3
2
1

· Zatwierdź wynik klawiszem Enter lub ikoną [image: ]
· Wyłącz z dalszych analiz obiekt PartBody, który zawiera objętość wirnika
[image: ]
· Zmień nazwy powstałych Enclosure na Tank (zewnętrzna) i Impeller (wewnętrzna)
[image: ][image: ]
	Obliczenia uwzględniające ruch obrotowy wirników wymagają zwykle większej ilości obliczeń. Z tego względu jeśli jest to możliwe należy maksymalnie zmniejszyć wymaganą liczbę elementów siatki numerycznej. W tym ćwiczeniu zostanie wykorzystana symetria modelu i do obliczeń zostanie uwzględniona jedynie jedna czwarta objętości. W wyniku liczba elementów siatki numerycznej zostanie zmniejszona czterokrotnie.
· Z zakładki Design wybierz ikonę tworzenia płaszczyzn i wskaż oś Y w celu utworzenia płaszczyzny
[image: ]Wskaż oś Y

· Za pomocą narzędzia Move wskaż utworzoną płaszczyznę i obróć ją o 45° 
[image: ]Wskaż wektor obrotu

· Podobnie obróć drugą płaszczyznę o 135°
[image: ]
· Za pomocą polecenia Split Body wybierz bryłę Tank
[image: ]
· Wybierz jedną z płaszczyzn jako płaszczyznę tnącą a następnie LPM wybierz zaznaczony element w celu jego usunięcia
[image: ]Wskaż tą płaszczyznę

· Wykonaj analogiczne postępowanie dla bryły Impeller
[image: ]
· Postępuj analogicznie dla pozostałej części bryły, aby efekt końcowy był jak na rysunku poniżej
[image: ]
· Wyłącz widoczność płaszczyzn oraz wirnika
[image: ][image: ]
· Zamknij SpaceClaim.
5. [bookmark: _Toc3538734][bookmark: _Toc4763084]Generowanie siatki numerycznej
· Otwórz program Ansys Meshing klikając dwukrotnie LPM na komórkę Mesh lub kliknij prawym przyciskiem myszy (PPM) a następnie wybierz Edit
[image: ]
· Na ekranie zobaczysz moduł Meshing z wcześniej przygotowaną geometrią
[image: ]
· W drzewku po lewej stronie kliknij LPM Mesh – pojawi się okno Details of Mesh
[image: ]
· W polu Physics Preference wybierz opcję CFD
[image: ]
· W polu Solver Preference wybierz CFX
[image: ]
· U dołu widoczna jest „linijka” pozwalająca oszacować rozmiary obiektu. Jednostka długości jest 1 m z układu SI, który jest układem domyślnym w Ansys Meshing. W celu zmiany układu jednostek wybierz w menu głównym Units
[image: ]
· W celu obejrzenia modelu zastosuj wcześniej poznane metody ruchu w SpaceClaim
Kolejnym krokiem w generowaniu siatki numerycznej jest nadanie nazw powierzchniom. Nazwy te zostaną następnie wykorzystane przy ustawianiu warunków brzegowych podczas przygotowania symulacji numerycznej. W tym celu wykorzystuje się Named Selections.
· Z głównego paska menu wybierz filtr wyboru lic (face’ów)
[image: ]
· Kliknij LPM w zaznaczony poniżej na rysunku face (zrobi się zielony)
[image: ]
· Kliknij PPM i wybierz Create Named Selection 
[image: ]
· Wpisz nazwę powierzchni jako tank_periodic_1 i naciśnij OK. Utworzona nazwa powierzchni pojawi się w drzewku systemowym pod Named Selections
 [image: ]
· Wykonaj podobne czynności dla pozostałych powierzchni:
tank_periodic_2
[image: ]
Impeller_periodic_1
[image: ]
impeller_periodic_2
[image: ]
· W celu nazwania całej bryły wybierz 
[image: ]
· Zaznacz całą bryłę obszaru zajmowanego przez Tank i nazwij go Tank_domain
[image: ]
· Obszar zajmowany przez Impeller nazwij Impeller_domain
[image: ]
· W celu nazwania powierzchni wirnika wyłącz widoczność bryły Tank za pomocą PPM na Geometry > Enclosure\Tank11
[image: ]
· Ukryj widoczność powierzchni zewnętrznych w bryle Impeller wybierając PPM na danej powierzchni
[image: ]
· Majac widoczne jedynie powierzchnie wirnika wybierz PPM 
[image: ]
· Wybranym powierzchniom nadaj nazwę impeller_walls
[image: ]
· Włącz widoczność powierzchni za pomocą PPM Show Hidden Face(s)
[image: ]
· Włącz widoczność Tank
[image: ]
· Wygeneruj siatkę automatyczną za pomocą [image: ]
[image: ]
· Zapisz projekt za pomocą File > Save Project
[image: ]
· i zamknij moduł Meshing za pomocą File > Close Meshing

6. [bookmark: _Toc3538735][bookmark: _Toc4763085]Ustawienia symulacji numerycznej – preprocessing
· W Workbench w Component Syestems kliknij LPM na CFX
[image: ]
· Przy wciśniętym LPM przeciągnij moduł CFX na komórkę Mesh aż pojawi się czerwone pole Transfer A3
[image: ]



· Kliknij PPM na Mesh i wybierz Update. Ma to na celu wysłanie do programu CFX siatki numerycznej w odpowiednim formacie
[image: ]
· Ikona Mesh zmienia status na zaktualizowany. Kliknij dwukrotnie na Setup w celu przejścia do CFX – programu do przeprowadzania symulacji numerycznych CFD
[image: ]
· Otwiera się okno dialogowe Ansys CFX

[image: ]


· Klikając PPM na Default Domain usuń domyślną domenę obliczeniową
[image: ]
· Za pomocą ikony tworzenia domen [image: ] utwórz domenę o nazwie tank
 [image: ]
· W polu Location wybierz Tank_domain. Jest to nazwa, która została utworzona w module Meshing

 [image: ]
· Płynem roboczym w tym ćwiczeniu jest powietrze, więc w polu Material wybierz Air at 25C

 [image: ]

· Przejdź do zakładki Fluid Models i wybierz opcję Heat Transfer jako None w celu nie uwzględnienia wymiany ciepła oraz model k-Epsilon w celu zamodelowania turbulencji (przepływ w tym przypadku jest turbulentny). Zatwierdź przyciskiem OK.
 [image: ]
· Utwórz drugą domenę o nazwie impeller
· W polu Location wybierz Impeller_domain. Jest to nazwa, która została utworzona w module Meshing

 [image: ]
· Płynem roboczym w tym ćwiczeniu jest powietrze, więc w polu Material wybierz Air at 25C

 [image: ]

· W polu Domain Motion zastosuj następujące ustawienia
[image: ]
· Przejdź do zakładki Fluid Models i wybierz opcję Heat Transfer jako None w celu nie uwzględnienia wymiany ciepła oraz model k-Epsilon w celu zamodelowania turbulencji (przepływ w tym przypadku jest turbulentny). Zatwierdź przyciskiem OK.
 [image: ]
· Za pomocą PPM wybierz Default Fluid Fluid Interface > Edit
[image: ]
· W zakładce Basic Settings > Frame Change/Mixing Model > Option wybierz Frozen Rotor i zatwierdź OK
[image: ]
· Za pomocą ikony tworzenia Interface[image: ] utwórz Interface o nazwie tank_periodic
[image: ]
· W zakład Basic Settings zastosuj następujące ustawienia w celu utworzenia periodycznych (okresowych) warunków brzegowych
[image: ]
· W zakładce Mesh Connection zastosuj opcję GGI
[image: ]
· Analogicznie utwórz warunki brzegowe o nazwie impeller_periodic w domenie impeller
[image: ]
[image: ]
· W polu Solver wybierz Solver Control
[image: ]
· W zakładce Basic Settings wybierz High Resolution dla Turbulence Numerics i ustaw minimalną i maksymalną liczbe iteracji na 200. Zatwierdź OK
 [image: ]
· Kliknij ikonę tworzenia wyrażeń [image: ] i utwórz Expression obliczające moment obrotowy na powierzchni ścian wirnika (wyrażenie torque()@REGION:impeller_walls )
· Na podstawie utworzonego expression utwórz punkt monitorujący moment obrotowy
· Zapisz projekt [image: ] i zamknij CFX Pre
· W Workbench kliknij PPM na Solution i wybierz Edit 
 [image: ]
· Zastosuj następujące ustawienia i rozpocznij obliczenia za pomocą Start Run
[image: ]
· Otwórz zakładkę User Points. Solver Manager zakończy obliczenia po 200 iteracjach. Kliknij OK po zakończeniu obliczeń i wyłącz Solver. 
· W Workbench zapisz projekt i kliknij dwukrotnie LPM na Results w celu zobaczenia wyników w CFD Post
[image: ]

[bookmark: _Toc3538736][bookmark: _Toc4763086]Lista zadań 11
Zad. 1
Pokaż rozkłady prędkości w płaszczyźnie XY dla Z = 0 m i YZ dla X = 0 m.
Zad. 2
Pokaż rozkłady wektorów prędkości w płaszczyźnie XY dla Z = 0 m i YZ dla X = 0 m.
Zad. 3
Pokaż rozkłady linii prądu na w płaszczyźnie XY dla Z = 0 m i YZ dla X = 0 m.
Zad. 4
Oblicz w tabeli wartość momentu obrotowego na wirniku w kierunku Z.
Zad. 5
Wykonaj analogiczne obliczenia dla modelu turbulencji SST (Shear Stress Transport) i porównaj je z uzyskanymi za pomocą modelu k-ε.
· W Workbench > Project Schematic wybierz PPM na komórkę B (CFX) i zmień nazwę na SST
[image: ]
[image: ]
· Wybierz PPM na komórce B (Solution) i następnie Duplicate i nadaj nazwę SST
[image: ]
· Edytuj model SST i zmień model turbulencji z k-ε na SST
· Wykonaj obliczenia dla modelu SST
· Po zakończeniu obliczeń zamknij moduł Solver Manager i z Component Systems LPM przeciągnij moduł Results do Project Schematic
[image: ]
· LPM wybierz komórkę B3 i przenieś do C2
[image: ]
· Przenieś komórkę D3 do C2
[image: ]
· Otwórz komórkę C2 przez dwukrotne kliknięcie LPM – program CFD Post wczytuje wyniki dla obu modeli
· [bookmark: _GoBack]Przed porównywaniem wyników włącz synchronizację widoków
[image: ]
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